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1. Introduction

First of all – don’t panic!  This document is only to be used as a reference and you are not
expected to read every page.  Installing the MeasureMax Run Engine really is simple; we’re just
trying to cover all of the bases for a multitude of products and situations.

“Section 2: Description” tells you about the product.

The minimum and recommended requirements for the Measurement Processor, operating
system, and computer configuration are listed in “Section 3: Minimum Requirements”.

If you want to install MMRE, then you should read “Section 4: Standard Installation”.

Occasionally, it is desirable to restore the image on the hard drive to the factory settings.
“Section 5: Restore Image” explains the pros and cons of this procedure.

“Section 6: Upgrade Measurement Processor” describes how to update the controller to your
Sheffield CMM.

“Section 7: Tools” identifies several tools that are handy to have for installations and system
maintenance.

There is a section on Frequently Asked Questions (FAQ’s).  “Section 8: Trouble Shooting” helps
you resolve common problems.  It also lists the phone numbers for our Service, Training and
Technical Support Departments.

We strive to make this a reference guide that you will find to be helpful and worthwhile.  Should
you have any recommendations or would like to see additional information, please contact us
through your Sheffield Sales Representative or our Technical Support Department.
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2. Description

The MeasureMax Run Engine (MMRE) enables PC-DMIS users to run part programs & service
utilities on Sheffield CMMs.

MMRE may be started from within PC-DMIS by clicking the File | Launch | MeasureMax menu
item. When PC-DMIS launches MMRE, it goes into an inactive state until MMRE is terminated.

You can also run MMRE directly if PC-DMIS is not running. “Section 7: Tools” describes how to
create a Desktop shortcut to MMRE.

2.1. Capabilities

Part Inspection Programs
Users can run their part inspection programs created in versions 2.xx to 6.xx of
MeasureMax. Access to the user’s part inspection program is via the File|Run menu item
or the Run button. A file open dialog is presented to allow the user to select the desired
part inspection program.

Users can also launch Assistant based part inspection programs (MeasureMax versions
5.xx and later) by DBL-CLICKING on the EXE in Windows Explorer or a shortcut to the
EXE.

If the user has not licensed the MeasureMax Run Engine the File|Run menu item and
the Run button are ‘greyed-out’. Also, if the user attempts to launch a part inspection
program by DBL-CLICKING on the EXE in Windows Explorer or a shortcut to the EXE, a
message box is displayed informing the user that "Your license does not allow you to run
Part Inspection Programs." This is followed by a message box alerting the user the
“Assistant failed to start”.

Standard Utilities
The installation includes the following standard MeasureMax utilities. These are
available even if the user has not licensed the MeasureMax Run Engine.

• Probe Calibration
• Calibrate FCR25 Changer
• Calibrate Probe Changer
• Calibrate Stylus Changer
• MP Configuration Save/Restore
• ProGage Rotary Table Align
• Rotary Table Align
• Rotary Table Center Calibration
• B89 Ball Bar
• B89 Repeatability
• B89 VPRT
• ISO 10360 Probing
• ISO Sphere Scan
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Service Utilities
The installation includes the following MeasureMax Service utilities. These are available
even if the user has not licensed the MeasureMax Run Engine. If the MeasureMax Run
Engine is not licensed the utilities are available under the Service menu item. If the
MeasureMax Run Engine is licensed they are available in the Utilities folder in the part
repository via the File|Run menu item and the Run button. Note that B89 Step Bar
Linearity and SP600 Test utilities are licensed separately.

• B89 Step Bar Linearity
• B89 Z-Roll
• ISO 10360—2 (VDI)
• SP600 Test
• CMM Exerciser
• Five Ball Repeat
• Ph9 – Ph10 Test

Machine Menu
Items in the MeasureMax Run Engine Machine menu allow the user to clear controller
errors, abort a running part inspection program, abort an in-process command, or set
properties related to the controller (e.g. communications port, baud rate).

Monitors
The MeasureMax Run Engine includes the following standard MeasureMax monitors;
XYZ, Trace, Report, and Prompt monitors.

2.2. Limitations

Real Time Statistics
Support for the Real Time Statistics monitor is not included in the MeasureMax Run
Engine.

Single Touch Interface
Support for the Single Touch Interface monitor is not included in the MeasureMax Run
Engine.

Q-DAS
Support for the Q-DAS monitor is not included in the MeasureMax Run Engine.

IQ-FormFit
Support for the IQ-FormFit application is not included in the MeasureMax Run Engine.

CADPath
Support for the CADPath application is not included in the MeasureMax Run Engine.
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3. Minimum Requirements

3.1. Software

MeasureMax and MMRE use some of the same components, Therefore these
products are not to be installed on the same system.

3.2. Measurement Processor

This software requires MP30/35/30-II firmware V19.2 or SMP-300 firmware V22.0 (or
later) or SMP-400 firmware V 106.0 (or later). Note that some features require the SMP-
400 controller. Some features in MeasureMax+ 6.5 require SMP-400 firmware V109.0.

3.3. Microsoft® Software

Microsoft Windows 2000 Professional or Windows XP Professional is the required
operating system for MMRE 1.00.

MMRE does not use Visual Basic, nor require it to be installed.

Power User privileges are needed to install MMRE.  To run MMRE the user must have
Power User privileges and the desktop icons must have Power User access
permissions.
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3.4. Computer Configuration

Due to the complexity of the MMRE and PC-DMIS software system and the variety of
computer hardware currently available, Sheffield cannot warrant the software to run
correctly on all computer systems nor can our Technical Support Department provide
support for third-party computer systems. The following are the current minimum
operating system hardware requirements for a MMRE system. Other optional software
packages available from Sheffield Measurement may have additional hardware
requirements. Systems provided by Sheffield exceed the minimum requirements.

Minimum system requirements
Computer/Processor 1 GHz or higher Pentium-compatible CPU.
Memory At least 256 megabytes (MB) of RAM; more memory generally improves responsiveness.
Hard Disk 1.5 gigabytes (GB) of available hard disk space*
Drive CD-ROM or DVD drive.
Display Super VGA (800 × 600) or higher-resolution video adapter and monitor
Keyboard Keyboard and Microsoft Mouse or compatible pointing device
Operating System Microsoft Windows® XP Professional or Windows® 2000 Professional
Additional Information http://www.microsoft.com/windowsxp/pro/evaluation/sysreqs.asp

http://www.microsoft.com/windows2000/professional/evaluation/sysreqs/default.asp

* Actual requirements will vary based on your system configuration and the applications
and features you choose to install. Additional available hard disk space may be required
if you are installing over a network.

MMRE is released on a CD-ROM and service packs are usually released on floppy
disks, so you will need the appropriate devices for installations.
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4. Standard Installation

The installation of MMRE is very simple, but if you are running any MeasureMax products on
the system stop.  MMRE and MeasureMax do not run on the same system.

Before performing any software installation, it is always a good idea to backup any data files
and part programs that exist solely on your PC. It is your responsibility to safeguard your
system. Sheffield Measurement is not liable for unrecoverable data.

You must have these items before you begin the installation:
• ‘MeasureMax Utilities for PC-DMIS 3.6’ distribution kit (CD-ROM) and any related

service packs or updates. Note that this CD-ROM is commonly referred to as the MMRE
CD.

• PC-DMIS hardware security key. This is also known as a port lock.
• Install from an account that is a member of the Administrator group.

Follow these steps to install MMRE:

1. Compare your system configuration to “Section 9: Minimum Requirements”.  Your
system must meet or exceed the requirements for the products that you will be using.

2. PC-DMIS 3.6 or higher should be installed. Refer to the PC-DMIS installation
instructions for further information.

3. Attach your PC-DMIS security key to the computer.
4. Terminate all applications
5. If the MeasureMax Run Engine (MMRE) is already installed, it must be uninstalled. Use

the ‘Add or Remove Programs’ applet in Control Panel to do this.
6. Run Setup on the MMRE CD.

• Place the ‘MeasureMax Utilities for PC-DMIS 3.6’ CD-ROM in the drive.
• On the Taskbar, click the Start and Run buttons.
• In the textbox type “D:\Setup”.  If your CD drive is not “D”, then enter the correct

drive.
• Click OK.

7. Follow the prompts.
8. This should complete the installation process. Do not remove the PC-DMIS security key.

It is required to run PC-DMIS.
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5. Restore Image

If you purchased a new computer system with ‘MeasureMax Utilities for PC-DMIS 3.6’ from
Sheffield, you will have received ‘Recovery / Installation PC-DMIS 3.6’ recovery disks that
enable you to restore the disk to the factory settings with the Windows XP operating system.
This process is similar to formatting the hard drive; that is, it destroys all files on the drive and
there is no way to recover this data.

If you have a MeasureMax product and PC-DMIS on your system, then you may have received
a recovery CD for MeasureMax+ or MaxLite in addition to the PC-DMIS recovery CD. In the
event you want to restore your system to the factory settings for both MeasureMax and PC-
DMIS, follow these steps:

1. Install the MeasureMax recovery CD. See the DELL Startup Instructions for Sheffield
Recovery CD of MeasureMax or MaxLite.

2. Install PC-DMIS and MMRE. See “Section 3: Standard Installation”.

To recover only the PC-DMIS and MMRE products with the Windows XP operating system, you
need to follow only one step:

1. Install the PC-DMIS recovery CD. See the DELL Startup Instructions for Sheffield
Recovery CD of PC-DMIS.

Windows XP requires activation. You must activate within 60 days. A notification to activate
appears periodically in the notification area on the taskbar, for example:
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Click on the indicated icon in the notification area and the following dialog will be displayed.

Follow the instructions to complete the activation process.
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6. Upgrade Measurement Processor

Before the Measurement Processor (MP) is upgraded, it is strongly recommended that the user
carefully review the modifications and enhancements that were implemented from the old
version to the new version.

As a safety measure to protect your configuration data, you must run MeasureMax, MaxLite
or MMRE and save a copy of the MP configuration data using the ‘MP Configuration
Save/Restore’ utility.  This is required before the upgrade is started - and again - after the
upgrade is completed.

The SMP-300, SMP-350 and SMP-400 measurement processors contain flash memory that can
be upgraded by running a special program on your computer. Upgrading the MP30/35/30-II
measurement processors requires opening the MP unit to replace the firmware chips.

To perform the upgrade, follow the instructions that are provided with the upgrade kit.  If you
prefer to have a service engineer do the upgrade, or if a more extensive upgrade is needed,
please contact your Sheffield Sales Representative or our Service Department (phone numbers
are in Section 8).
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7. Tools

This section contains a variety of useful tools and procedures to maintain a healthy system.

7.1. Display Version Numbers

To display operating system, version, service pack and amount of physical memory:
• On the Taskbar, click the Start button.
• Select Settings and Control Panel.
• Click the Help menu and About Windows.

To display the version and service pack for Visual Basic:
• On the Taskbar, click the Start button then select Programs and Microsoft

Visual Basic.
• Click the Help menu and About Microsoft Visual Basic.

To display the version of MeasureMax Run Engine:
• Run MMRE.
• In the MeasureMax Run Engine, click the Help menu and About.

To display the version of firmware in the Measurement Processor with MeasureMax:
• Run MeasureMax Run Engine.
• The MP must be online.  If the name of the CMM is not displayed in the status

panel at the bottom of the Control Center window, click Machine and Start to
select the CMM.

• Select Machine, Properties and the Configuration tab.

7.2. CMM Properties

To display the CMM Properties with MMRE:
•  Run MMRE.
• The MP must be online.  If the name of the CMM is not displayed in the status

panel at the bottom of the MeasureMax Run Engine window, click Machine and
Start to select the CMM.

• Select Machine and Properties.
• Click the Communications tab for the RS-232 settings.

The communication settings are listed below.  During installation, the SMP-300 is used
as the default machine.  Typically, COM1 is used as the communication port.

SMP-300,
SMP-350

SMP-400 MP30/35/30-II

Baud Rate 19200 57600 * 9600
Data Bits 8 8 8
Stop Bits 1 1 1
Parity Odd Odd Odd
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Notes:
*  Scanning machines with SMP-400 can communicate at either 57600 or
115200. The higher rate is recommended for data transfers of analog scans.

7.3. Create Shortcut to Run MeasureMax Run Engine

To create a shortcut to run a program or application:
• On the Taskbar, click the Start button.
• Click Settings and Taskbar & Start Menu.
• Select the Start Menu Programs tab in the Taskbar Properties window.
• Click Add and Browse.
• Open the file that will run the application.  The MeasureMax applications and files

are listed below.  All MeasureMax files are located in the MeasureMax\Bin folder
(typically, C:\Program Files\MeasureMax\Bin).

MMRE MMRunEngine.exe
 Click Next.

• In Select Program Folder, click Desktop and Next.
• In Select a Title for the Program, enter the product name and click Finish.

7.4. Acrobat Reader

Document files with the extension ‘pdf’ can be opened with Adobe® Acrobat Reader.

If you would like to use Acrobat Reader, it can be installed from the MMRE CD, or it can
be downloaded for free from the Adobe web site.  The web address is:
www.adobe.com/acrobat.

Follow these steps to install Acrobat Reader:
• Use Windows Explorer to display the “Misc\Acrobat” folder on the MMRE CD.
• To install version 5.1, double-click the AcroReader51_ENU.exe file. Version 5.1

is the preferred version.
• Follow the prompts.  This is a compressed file that will install the product to the

specified folder.

To run Acrobat Reader, double-click the ‘pdf’ file or select Adobe Acrobat Reader from
the Programs menu.

Follow these steps to uninstall Acrobat Reader:
• On the Taskbar, click the Start button.
• Select Settings, Control Panel and Add/Remove Programs.
• Use the Remove button in the Add/Remove Programs window to uninstall

Acrobat Reader.
• Select Close to exit the Add/Remove Programs window.
• If the Control Panel window is open, close it.
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7.5. Microsoft Explorer Window

There are several different methods to open Windows Explorer.  Here are two of them:
• On the Taskbar, click the Start button then select Programs, Accessories, and

Windows Explorer.
• On the Taskbar, click the Start button with the right mouse button and select

Explore.

When you open Windows Explorer, you may want to change some settings so it will
display more information.  Here are some suggested settings:

• On the Tools menu, click Folder Options.
• Click the View tab.
• Change the advanced settings to match the settings in this illustration.  It is

important that ‘show hidden files and folders’ is enabled and ‘hide file extensions
for known file types’ is not checked.

7.6. Microsoft Word Viewer

Document files with the extension ‘doc’ can be opened with Microsoft WordPad,
Microsoft Word, or Microsoft Word Viewer.
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With the Microsoft® Word Viewer 97/2000, Microsoft Word users can share documents
with those who do not have Word and users without Word can open and view Word
documents.  This product also allows users who wish to post rich-formatted Word
documents on the Internet to expand their online audience to people who might not have
Word.  This viewer also allows users to view and print documents created in the Word
native file format, even if they do not have Word.  Users are allowed to zoom, outline, or
view page layout, headers/footers, footnotes, and annotations.

If you would like to use Word Viewer, it can be downloaded for free from the Microsoft
web site.  The URL is:

http://office.microsoft.com/downloads/2000/wd97vwr32.aspx

7.7. RegClean

It is important to run RegClean after products have been added or removed.  RegClean
analyzes Windows Registry keys stored in a common location in the Windows Registry.
It finds keys that contain erroneous values, and after recording those entries in the
Undo.Reg file, it removes them from the Windows Registry.

Follow these steps to install RegClean:
• Use Windows Explorer to display the “Misc\RegClean4.1a” folder on the MMRE

CD.
• Double-click the Regcln41.exe file and follow the prompts.  This is a compressed

file that will install three files to the specified folder.
• Right-click the RegClean.exe file and select Create Shortcut.
• Drag the shortcut file to the Desktop.  You may want to rename the shortcut to

“RegClean”.
• Click the Readme.txt file to learn more about this utility.

To run RegClean, click the shortcut or the executable file and follow the prompts.
Continue to run RegClean until there are no more errors to fix.

7.8. RegEdit

Registry Editor is an advanced tool that enables you to change settings in your system
registry, which contains information about how your computer runs. You should not edit
your registry unless it is absolutely necessary.  If there is an error in your registry, your
computer may become nonfunctional.  If this happens, you can restore the registry to its
state when you last successfully started your computer. For instructions, see Help in
RegEdit.

Follow these instructions to access the Sheffield Measurement folder in the System
Registry.  Displaying keys and values in the registry is very similar to displaying folders
and files in Windows Explorer.  To expand and compress keys, you can click the plus
sign preceding the key name or you can double-click the key name.

• On the Taskbar, click the Start and Run buttons.
• In the textbox type “RegEdit” and click OK.
• The following 6 keys will be displayed:
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HKEY_CLASSES_ROOT
HKEY_CURRENT_USER
HKEY_LOCAL_MACHINE
HKEY_USERS
HKEY_CURRENT_CONFIG
HKEY_DYN_DATA

• Select HKEY_LOCAL_MACHINE and another list of keys will be
displayed.

• Select SOFTWARE and another list of keys will be displayed.
• Highlight the SheffieldMeasurement key.

Since probe tips should be calibrated frequently (e.g., at least once a week), it may not
be necessary to save this data.  However, If you do want to save a copy of your probe
storage files, follow these steps:

• Select Probes in the Sheffield Measurement key.
• Click the Registry menu at the top of the window.
• Click Export Registry File.
• Export the file for later retrieval.

If you want to retrieve a copy of your probe storage files, follow these steps:
• Select Probes in the Sheffield Measurement key.
• Click the Registry menu at the top of the window.
• Click Import Registry File.
• Import the probe file that you previously saved.

If MeasureMax products are not installed and you want to delete its registry,
follow these steps.  Be aware that once you delete a key from the registry, it
cannot be recovered.

• Select the Sheffield Measurement key.
• Click the Edit menu at the top of the window.
• Click Delete.

Always remember to close the Registry window when you are finished.

7.9. Windows 2000 Service Pack

Service pack 2 must be installed with Windows 2000 Professional.  Typically, the service
pack is installed immediately after the operating system is installed; however, sometimes
it is necessary to reinstall the service pack after other products such as Visual Basic or
MeasureMax+ have been installed.

If you install a non-English version of Windows 2000 Professional, then you must install
the appropriate service pack for that language.  Only the English version is provided on
the MMRE CD.  You can download the appropriate Windows 2000 Service Pack 2 from
the Microsoft web site at:
http://www.microsoft.com/windows2000/downloads/servicepacks/sp2/default.asp.
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Follow these steps to install the service pack:
• Use Windows Explorer to display the “w2ksp2” folder on the MMRE CD. This

folder contains the English version of the service pack.  If you installed a non-
English version of Windows 2000 Professional, do not install this file.  You must
obtain the correct service pack for your language.

• Double-click the W2KSP2.exe file and follow the prompts.

If the following error message is ever displayed, click OK. Windows must be restarted
and the service pack must be reinstalled.

7.10. Windows XP Service Pack
Service pack 1 must be installed with Windows XP Professional.  Typically, the service
pack is installed immediately after the operating system is installed; however, sometimes
it is necessary to reinstall the service pack after other products such as Visual Basic or
MeasureMax products have been installed.

If you install a non-English version of Windows XP Professional, then you must install
the appropriate service pack for that language.  Only the English version is provided on
the MMRE CD.  You can download the appropriate Windows XP Service Pack 1 from
the Microsoft web site at:
http://www.microsoft.com/WindowsXP/pro/downloads/servicepacks/sp1/default.asp

Follow these steps to install the service pack:
• Use Windows Explorer to display the “wxpsp1” folder on the MMRE CD. This

folder contains the English version of the service pack.  If you installed a non-
English version of Windows XP Professional, do not install this file.  You must
obtain the correct service pack for your language.

• Double-click the XPSP1.exe file and follow the prompts.
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If the following error message is ever displayed, click OK. Windows must be restarted
and the service pack must be reinstalled.

7.11. Register Files
Occasionally, you may need to register a file if you receive an update from Technical
Support.  The command to register a file is entered in the Run dialog box.

Follow these steps to register or unregister a file:
• To open the Run dialog box, click the Start button on the Taskbar and then

Run.
• If you prefer, you can use the Browse button to load the file name into the Open

box.  Depending on the file type, you may need to change File of type to All
Files.  If you still can not view the file, then refer to Microsoft Explorer Window in
Section 7 for assistance.  As an alternative, you can always type the file name
instead of clicking the file.

• To register a file, enter the command and file name in the Open box and click
OK.  This illustration shows the Run dialog box.  Of course, you need to replace
“c:\folder\file” with the correct drive, folder path and file name.  You also need to
insert quotation marks around the file specification and insert a space between
the command and file specification.  Before you click OK, proceed with the
following steps to select the correct command and syntax.
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• To register a ‘dll’ file, enter the following in the Open box:
REGSVR32  “c:\folder\file”

• To unregister a ‘dll’ file, enter the following in the Open box:
REGSVR32  -U  “c:\folder\file”

• To register an ‘exe’ file, enter the following in the Open box:
“c:\folder\file”  /REGISTER

• To unregister an ‘exe’ file, enter the following in the Open box:
“c:\folder\file”  /UNREGISTER
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8. Trouble Shooting

This section on resolving problems lists some common questions that may occur when MMRE
is installed.  If you have a problem that isn’t addressed here, please contact us.  Our phone
numbers are listed at the end of this section.

 Cannot establish communications with the MP.
• Make sure the RS-232 cable from the MP is firmly plugged into the serial port on the

computer.  Typically, the MP uses Com1.
• Make sure the product is using the correct machine.
• Make sure the communication settings are correct.  Refer to CMM Properties in

Section 7 for assistance.
In MeasureMax Run Engine window, select Machine menu and Properties.  In the

CMM Station Properties dialog, select the Communications tab.  Correct the
settings and press OK.

 MP 105 error: Host to MP communication interrupted.
• This is an informational message that frequently occurs when the computer has

been restarted.  It is normal for some random characters to be generated over the
RS-232 line when the PC power is cycled.  In this case, the error can be cleared and
ignored.  This is less likely to occur if the MP is turned off when you start your
computer.

• If the error cannot be attributed to restarting the computer, then make sure the
communication cable is not loose.

• If the error occurs frequently, call your Sheffield service representative.
• Refer to the MMRE online help system for additional information.

 A MeasureMax part program generated an unexpected error and I cannot restart it.
• Exit Windows and log on again.  This clears aborted tasks from memory so the

product can be started.
• Or, use the Task Manager to ‘end’ the dangling tasks.  Press the Ctrl, Alt and Del

keys simultaneously to display the Windows Task Manager.  If any of the MMRE
tasks are running, press the End Task button to remove them.  The easiest way to
determine which tasks belong to MMRE is to terminate all other applications that
may be running.

 Shortcut on the Desktop does not run the MMRE application.
• If MMRE was reinstalled, the installation folder may have been changed.  Delete the

shortcut and refer to Create Shortcut  in Section 7 to create a new shortcut.

 Background of some MMRE windows is two shades of gray.
• The Desktop display scheme must be Windows Classic.  Right-click the Desktop and

select Properties to display the Display Properties.  Select the Appearance tab.
Set Scheme to Windows Standard and click OK.

 Some of the icons in MMRE windows have a grainy appearance.
• The color palette must be greater than 256 colors.  Right-click the Desktop and

select Properties to display the Display Properties.  Select the Settings tab.  Set
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Colors to High Color (16 bit) or True Color (32 bit), click Apply and follow the
prompts.

8.1. Training

Please visit our web site for the current training schedule.  Our web address is
www.sheffieldmeasurement.com.

You can also contact your Sales Representative or call our Training Department at 1-
800-535-1236.

International users must contact your Sales Representative or visit our web site at
www.sheffieldmeasurement.com.

8.2. Sheffield Aftersales Support

To order parts or arrange for service, domestic users may call us at 1-800-535-1236.

International users should contact your Sales Representative.  As an alternative, you
may e-mail a message to TechSupport@sheffieldmeasurement.com or send a fax to 1-
920-906-7015.

8.3. Technical Support

For 24 hour technical phone support, domestic users may call the Sheffield aftersales
support line at 1-800-535-1236.

We prefer that you contact us via e-mail on the Internet.  Our address is
TechSupport@sheffieldmeasurement.com.  If you cannot call us or do not have access
to e-mail, then you can send us a fax at 1-920-906-7015.

International users may contact your Sales Representative, send us an e-mail message,
or send us a fax at 1-920-906-7015.

Before you contact us, please have the version numbers and service packs for your
installed operating system, MeasureMax products and Measurement Processor
available.  It is particularly important that you try to narrow a problem down to the actual
cause and provide us with precise details of the situation.  A form is listed on the next
page that shows the information we are looking for. To provide the best service, please
provide this information when you contact us.
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8.4. Technical Support Form

SHEFFIELD MEASUREMENT Web: www.sheffieldmeasurement.com
E-Mail: techsupport@sheffieldmeasurement.com
Fax: 1-920-906-7015  (Attn: Tech Support)

Date _________________________________________ Phone _________________________
Company Name ________________________________ Fax ___________________________
Address ______________________________________ E-Mail ________________________
Contact Person _________________________________ Pager _________________________

Machine Configuration:
CMM SERIAL #: (back of CMM) _________________ MP Version ____________________
__ Gantry, __ RS, __ 1808, __ Horizon, __ Discovery, __ Endeavor
CMM MODEL: (front of CMM)___________________ (circle) Manual  or Automatic (DCC)
Measurement Processor:  __ SMP400, __ SMP300, __ MP35, __ MP30, __ MP4
Probe Head:   ___ PH9/PH10  (motorized rotating head)     or      ___ (manual probe head)
Probe:  Automatic Probe Changer or Stylus Changer  (Y/N)?  _____
Probe Type: __ TP1, __ TP2,  __ TP6, __ TP7, __ TP20, __ TP200, __ SP600

Computer Configuration:
Model: _______________________________ Dell, OmniTech, G&L, HP, Digital, other_____
Printer: _______________________________ Network Card: __________________________

Software:
Operating System: __ Win XP, __ Win 2000,  __ Win 95, __ Win/NT,  __ OS/2 Ver?__,
 __ HP/DOS
CMM Software:  (PC-DMIS, MMRE, MeasureMax, MaxLite, DirectInspect, OFI, MP4/ST, other
______) Ver? ___
Programming Software:  __VisualBasic, __MSBasic, __HP Basic, __Vax Fortran Ver? _______
Attended Training (y/n)? ___ Date and Class? ________________________________________

Question:  (What is the nature of your problem?  Can the problem be duplicated?)
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

What have you done to try to resolve this issue?
________________________________________________________________________
________________________________________________________________________

Suggestions:  List all errors and messages appearing on the RCU, MP, Screen, &
XYZ Display, including symptoms and any recent changes/modifications to the system.
Use the On-Line HELP Facility.  Close ALL programs, Shutdown Windows Operating
System, Turn off the computer, Turn off the CMM (MP), then power up the computer
followed by the MP.   


